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Accessible Technology and Information 
Websites and learning management systems have a variety of content including web 
pages, online courses, text files in various formats (Word, PDF, Excel, PowerPoint) and 

audio/video recordings.  This publication, The Athens State University Accessible 
Technology and Information Guidelines is intended to assist faculty and staff in making 

digital content accessible.  This guide provides information on the standards for creating 
and modifying existing and new digital content that is accessible by all persons with or 

without disabilities. Additionally, this guide is augmented by the many available 
resources on accessibility referenced throughout.  

 
Accessibility issues related to the public facing, Athens State University website, are not 

addressed in this document specifically because the website is centrally managed, 
however, the same rules apply to the website and all content access through it.  Faculty 

and staff may contribute content for publication on Athens.edu, but do not manage the 
content directly.  The University has already begun the work to address the public facing 

website accessibility issues.   

What is accessible technology and information? 
Technology and information is considered to be accessible if it can be accessed in a 

variety of ways and does not rely on a single sense or ability of the user.  Major 
accessibility issues fall into three broad areas for higher education: web-based learning, 

in-class technology, and document preparation. Considering document preparation, a 
PDF document on a web site can be opened and read by a sighted person, but for it to 

be considered accessible, it should be formatted correctly so that it can also be read out 
loud by a screen reader for a blind person.  This requires the PDF file be structured so 

that not only can it be read aloud by the screen reader, but, the content is also 
understandable when read out loud.  In-class technology such as a projector might be 

used to review the PDF document in class.  For a live, classroom presentation to be 
considered accessible, the document should be made available so that a low-vision 

student can have the chance to read the document before class with a screen reader.  

Why is Accessibility Important? 
The majority of the work completed at a university relies on the use of technology, 

therefore, accessible technology and information is important.  Following accessibility 
standards improves content overall because it can serve all users whether or not they 

are disabled.  The captioning of videos not only helps individuals with a hearing 
impairment, captioning also provides an alternate way for the content to be used by a 

hearing person.  
 

Background on Accessibility Laws 
The Americans with Disabilities Act (ADA) 1990 requires covered entities to furnish 

appropriate auxiliary aids and services where necessary to ensure effective 
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communication with individuals with disabilities unless doing so would result in a 

fundamental alteration of the program/service or cause an undue burden.  Examples of 
auxiliary aids include audio recorded texts, Braille materials, large print, captioning, and 

any other method that make audio and visual media available.  
 

In 1996, the United States Department of Justice issued a policy ruling stating that ADA 
Titles II and III require state and local governments along with the business sector to 

provide effective communication regarding programs, goods, or services when 
communicating through the Internet.  Because of the extent to which government and 

businesses use web-based delivery of information, goods, and services, it is also 
necessary to make web content accessible.  

 
Section 508 of the Rehabilitation Act of 1973, as amended (29 U.S.C. § 794 (d)) in 1998 

by Congress, requires Federal agencies to make their electronic and information 
technology accessible to people with disabilities.  An accessible information technology 

system is one that can be operated in a variety of ways and does not rely on a single 

sense or ability of the user.  
 

As originally written, Section 508 did not automatically apply to institutions of higher 
education even if they receive federal funding. However, states that receive funds 

through the Assistive Technology Act are required to comply with 508.  Alabama has 
received funding through the Assistive Technology Act for STAR – Alabama’s Statewide 

Assistive Technology Resource.   
 

Content Covered by Section 508  
The Web Content Accessibility Guidelines (WCAG) 2.0 are an international voluntary 

standard for web accessibility that is more comprehensive and up-to-date than the 
original Section 508 standards.  The Section 508 revision was finalized in January 2017 

and will require WCAG 2.0 at priority level AA conformance.  This revision removes the 
biggest and most common barriers for disabled users.   

 

The new Section 508 standards apply to the following specific areas:   
 

1. Public-facing content that includes electronic information and data.  
2. Non-public facing content that falls within the following nine categories of official 

communications: 
a. emergency notifications 

b. initial or final decisions adjudicating an administrative claim or proceeding  
c. internal or external program or policy announcements  

d. notices of benefits, program eligibility, employment opportunity, or 
personnel action  

e. formal acknowledgements of receipt 
f. survey questionnaires  

g. templates and forms  
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h. educational and training materials 

i. intranet content designed as a Web page 
 

The deadline for compliance with Section 508 has been set for January 2018.   
Documentation on how the new Section 508 standards were developed can be found at: 

https://www.access-board.gov/guidelines-and-standards/communications-and-it/about-
the-ict-refresh/final-rule .   

Getting Started with Applying Accessibility Guidelines 
 

This guide has been developed to provide a structured set of resources to raise 

awareness and the level of understanding about the basic practices that make content 
accessible.  This guide relies on references to other resources to provide relevant, up-to-

date information and techniques.  There is an abundance of assistance through Internet 
and in software applications such as Microsoft Office. Training opportunities, both in 

person and online, will also be made available.  
 

The key to developing accessible content is to understand the obstacles to accessibility 

and how simple changes can make content accessible. Incorporating rules at the 
beginning of new content development is highly recommended to save time. However, 

there is a large amount of existing content that is available through the university web 
site and through the learning management system Blackboard. As such, all content that 

will be accessed by the public or accessed by students must be reviewed for accessibility 
issues.  

 
The following is a set of steps toward addressing accessibility:  

 
1. Become familiar with the WCAG 2.0 principles of accessible content by reading 

through the specific and useable information contained in this document. Learn 
about the techniques and application tools that can be used to aid in making 

digital content accessible.  
 

2. Address immediate needs of students first.  If you have a student who identifies 

their need for an accommodation, you are probably already working with 
Disability Services on course content modifications so the student can 

successfully access course content. 
 

3. Review all digital content used in online courses beginning with those that will 
be taught in the Fall 2017 semester. Although Blackboard is compliant with 

Section 508 requirements, the content accessed through Blackboard such as a 
file, an audio/video recording, software application, or another website, must 

also be accessible.  
 

https://www.access-board.gov/guidelines-and-standards/communications-and-it/about-the-ict-refresh/final-rule
https://www.access-board.gov/guidelines-and-standards/communications-and-it/about-the-ict-refresh/final-rule
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4. Review the quality of all audio/video recordings. Closed captioning and 

transcription cannot be completed on low quality recordings without expending 
a great deal of time and effort.  

 
5. Before purchasing textbooks, software applications, or hardware, go through 

the review the General Procurement Practices section later in this document.  
Don’t put money into a resource before assessing accessibility and usability. 

Book publishers are usually very aware of accessibility and have made a lot of 
effort toward meeting requirements.   

 
6. Review live classroom presentations by considering how an individual might be 

impacted if there are no alternative ways to access the materials you present.  
Having content online that follows accessibility standards is a first step to 

making a live classroom presentation fully accessible to all students. Blackboard 
has a great site on accessibility at: 

http://www.blackboard.com/accessibility.aspx  

 
7. Site Improve, a website governance product used to review web site for 

accessibility violations, has been purchased and is now used to review the 
public facing Athens.edu website.  Site Improve reviews both web page content 

and PDF documents for compliance to WCAG 2.0.  PDF files are created by 
converting source documents developed in Word, Excel, PowerPoint, to PDF 

format. You should also review any documents that you authored and published 
to the Athens State website against the WCAG 2.0 standards so you can modify 

source documents and republish as necessary. 
 

8. Attend an in-person training session.  Learn from your peers and meet the 
people who will provide support.   

 
9. Be receptive to feedback about your content.  As content is reviewed, issues 

will be found.  

 
10. Remember, you are not alone.  Help will be available to work in partnership 

with all faculty and staff to address the accessibility needs of the entire 
community.  

 
 

  

http://www.blackboard.com/accessibility.aspx
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WCAG 2.0 Guidelines  

 
WCAG 2.0 Guidelines have been adopted as a standard for making technology and 

information accessible (https://www.w3.org/WAI/WCAG20/quickref/ ). These guidelines 
cover the four principles of accessible content: perceivable, operational, understandable, 

and robust that should be applied when developing digital content accessed through a 
web interface or a standalone computer.   

 
The four principles are described in detail in twelve general guidelines listed below: 

 
1 Perceivable - Web content must be perceivable through more than one sense.  

 
1.1 Provide text alternatives for any non-text content so that it can be changed into 

other forms people need, such as large print, braille, speech, symbols or simpler 
language. 

1.2 Provide alternatives for time-based media. 

1.3 Create content that can be presented in different ways (for example simpler layout) 
without losing information or structure. 

1.4 Make it easier for users to see and hear content including separating foreground 
from background. 

 
2 Operable – The user interface should be navigable using alternative hardware.  

Example, have both mouse and keyboard functions. 
 

2.1 Make all functionality available from a keyboard. 
2.2 Provide users enough time to read and use content. 

2.3 Do not design content in a way that is known to cause seizures. 
2.4 Provide ways to help users navigate, find content, and determine where they are. 

 
3 Understandable – Make it understandable by using alternative or supplemental 

representations of information.  Example, supplement text with video, audio, 

illustrations. Likewise, text in the form of a transcript or closed captions can be added to 
videos.  

 
3.1 Make text content readable and understandable. 

3.2 Make Web pages appear and operate in predictable ways. 
3.3 Help users avoid and correct mistakes. 

 
4 Robust – Use consistent and accurate coding so that assistive technologies will work.  

 
4.1 Maximize compatibility with current and future user agents, including assistive 

technologies. 

https://www.w3.org/WAI/WCAG20/quickref/
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Microsoft Office Accessibility Rules/Techniques 
These accessibility rules apply to all online content.  Microsoft Office has a number 

of features to support the development of accessible content. 

 
Document Layout 

Accessibility Rule Reason/How 
Use Style elements in a hierarchical 

manner. 

Why:  Assistive Technology such as 

screen readers can better determine 
the difference between sections.  

 
Examples:  Heading 1, Title, Emphasis, 

Outline, etc. 
 

How: Select the text to format and 
then click the Home tab.  Choose the 

style from the Styles gallery. 

No flashing, flickering and/or animated 

text.   

Why: Flashing or flickering content can 

cause seizures and the Assistive 

Technology cannot decipher the 
content. Watch for use in Banner 

course banners.  

Page number must be created by a 

Microsoft Word process and not 
manually entered.   

Why:  Properly formatted page 

numbers allow assistive technology can 
identify the page number.   

 
How: To add page numbers to a 

document click the Insert tab, then 

click the Page Number button in the 
Header & Footer group. 

Footnotes must be created through 
Word Footnote tool. 

Why:  Assistive technology recognizes 
formal footnotes and works them into 

the body of the text when reading.   
 

How:  To create a footnote click on the 
References tab, then click the Insert 

Footnote button located in the 
Footnotes group. 

Bullet and numbering styles must be 

used as opposed to manually typed 
characters such as hyphens or dashes.   

 

Why: Assistive Technology recognizes 

these items as lists of information and 
will navigate them accordingly.   

How: Add bullets or numbers by 
choosing the Home tab, then select the 
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Accessibility Rule Reason/How 
Bullets or Numbering button in the 
Paragraph group. 

 

Track changes need to be accepted or 

rejected and then turned off 

Why:  Assistive Technology cannot 

consistently read them.   
How:  Turn off track changes in Review 

tab, and click the Track Changes 

button in the Tracking group. 
 

Comments and formatting marks must 
be turned off   

 

Why:  Assistive Technology cannot 
consistently read comments and 

formatting marks.  They get in the way 
of the intended message within the 

content.   
How:  To remove Comments select the 

Review tab.  Click the Delete button 

within the Comments group.  You will 
have the choice to delete comments 

and markups on the current slide or to 
the entire presentation. 

 

Final visual document checks need to 

be in the Print Preview.   
 

Why:  This will show items such as 

headers, footers, page numbers, and 
repeating table heading rows.   

How: To view a document click the File 
tab, and then choose Print.  The 

preview will display in the right panel 

of the Word window. 
 

All URLs must contain the correct 
hyperlink and display the fully qualified 

URL.   

Why:  Assistive Technology recognizes 
formal hyperlinks and it helps the 

impaired users to navigate to the 
linked destination. 

 

All the URL’s must be active and linked 
to the correct destination.   

Why:  Assistive Technology recognizes 
formal hyperlinks and it helps the 

impaired users to navigate to the 
linked destination. 
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Document Images 
Accessibility Rule Reason/How 
Complex images must have descriptive 

text immediately after the image. 

Why:  The descriptive text is read by 

the Assistive Technology and provides 
the impaired individual additional 

information regarding the image. 

The document must be free of 

background images or watermarks.   

Why:  Documents for visually impaired 

individuals are easier to read when 
they are free of background images or 

watermarks.   

How: To remove a watermark, click the 
Page Layout tab. Select Watermark 

from the Page Background group, then 
Remove Watermark. 

The image text wrapping style “In Line 
with Text” must be used for all images. 

Why:  Assistive Technology reads 
documents in a sequential order, if the 

image is not “In Line with Text” the 
image will be read out of order.   

 

How:  To make an image “In Line with 
Text”, right-click the image.  Choose 

Wrap Text from the drop down menu, 
and then select In Line with Text. 

Multiple associated images must be 
Grouped as One Object (i.e., 

Organizational Charts)  

Why:  When the images are grouped 
as one object, only one alt-tag needs 

to be applied to the non-verbal 
element. 

All multi-layered objects must be 

flattened into one image and use one 
Alternative Text (Alt Tag) for the 

image.   

Why:  When multi-layered objects are 

flattened into one image, only one alt-
tag needs to be applied to the non-

verbal element. 

Text boxes must not be used for simple 

graphics. 

Why:  Text boxes without content 

presents confusion to someone using a 
screen reader because the reader 

expects something to read.  
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Document Tables 

Accessibility Rule Reason/How 
All tables must read from left to right, 

top to bottom. 

Why: This is for proper reading order 

by the Assistive Technology 
How:  Plan table content layout so that 

it reads left to right, top to bottom.   

Tables containing ‘data’ must have the 
first row designated as a Header Row.  

Why: This aids the Assistive 
Technology in knowing where the 

heading information is located for each 
column.   

How: To designate the heading row(s), 
select the rows that contain the 

heading information.  Right-click the 
selected rows and choose Table 

Properties.  In the Table Properties 
dialog box select the Row tab and 

check “Repeat as header row at the top 
of each page”. 

Tables must not use merged cells.  Why: Assistive Technology cannot 

match the cells with the appropriate 
heading rows. 

How: Don’t merge cells 

Rows should not break across pages. Why: It makes it difficult for Assistive 

Technology to read.   

How: To stop rows from breaking 
select the rows that contains the 

heading information.  Right-click the 
selected rows and choose Table 

Properties.  In the Table Properties 
dialog box select the Row tab and 

uncheck “Allow row to break across 
pages.” 
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Additional Accessible Documents Requirements 
The Inspect Document function will 
check your document for hidden 

information, comments, track changes, 
headers, footers, watermarks, and 

other items.   
 

How: To run the Inspect Document 
select the File tab.  Choose Check for 

Issues, Check Accessibility.  Note: it is 
good practice to run the Inspect 

Document on a copy of the file, 
preserving the original in case there 

are issues. 

The document file name must not 
contain spaces and/or special 

characters.   

To separate words in a file name use 
the hyphen (-). 

The document file name must be 

concise, generally limited to 20-30 

characters. 

File name should make it clear the 

content of the file clear in the context 

in which it is presented. 

The document must utilize the 

recommended fonts. 

Recommended fonts: Times New 

Roman, Verdana, Arial, Tahoma, 
Helvetica and Calibri. 

The Document Properties (i.e. Subject, 

Author, Title, Keywords, and 
Language) must be properly filled out. 

To apply Document Properties click on 

the File tab, then Properties in the right 
pane to expand.  Choose Show 

Document Panel to expose the 
document properties and fill in the 

fields. 
 

Documents that contain a Table of 
Contents (TOC) need to be created by 

Microsoft’s Reference tool.   

TOC’s are generated by the styles that 
are applied to the document.  To 

create a TOC, click the References tab, 

then click the Table of Contents button 
in the Table of Contents group.  

Choose the style you would like to use, 
click the style to apply it to the 

document. 
 

A separate accessible version of the 
document must be provided when 

there is no other way to make the 
content accessible. 

Example: An organizational chart 
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Microsoft Office Online Accessibility Resources 
Microsoft has several helpful guides on creating accessible documents.  These guides are 
accessible from within any Office application (hit F1 key and search on the term 

“Accessibility”).  The following links provide web accessible documentation you can read 
anytime without being in an Office application. 

 

Resource Link Description 
Office Accessibility Center 

 
https://support.office.microsoft.com/clien

t/Office-Accessibility-Center-ecab0fcf-
d143-4fe8-a2ff-6cd596bddc6d 

 
 

Landing page with links to multiple 

resources on making content 
accessible.  This page has links to 

four topics: make content 
accessible; help for specific Office 

365 applications; demos on how to 
use accessibility features; and 

what’s new in accessibility.   

Overview:  Creating Accessible Office files 

 

https://support.office.microsoft.com/clien
t/Overview-Creating-accessible-Office-

files-868ECFCD-4F00-4224-B881-
A65537A7C155?NS=WINWORD&Version

=15&AppVer=ZWD150  
 

This link has a five minute video on 

creating accessible content using 

Microsoft Office.  
  

 

Create accessible Word documents 
 

https://support.office.microsoft.com/clien
t/Create-accessible-Word-documents-

4fbb34d6-264f-4315-98d1-

e431019e6137  

Online video tutorial on how to 
create accessible Word documents.   

Make your Word documents accessible 

 
https://support.office.microsoft.com/clien

t/Make-your-Word-documents-accessible-
D9BF3683-87AC-47EA-B91A-

78DCACB3C66D?NS=WINWORD&Version
=15&AppVer=ZWD150  

 

Learn how to create Word 

documents that are more accessible 
to people with disabilities, or who 

are using assistive technologies. 
 

  

https://support.office.microsoft.com/client/Office-Accessibility-Center-ecab0fcf-d143-4fe8-a2ff-6cd596bddc6d
https://support.office.microsoft.com/client/Office-Accessibility-Center-ecab0fcf-d143-4fe8-a2ff-6cd596bddc6d
https://support.office.microsoft.com/client/Office-Accessibility-Center-ecab0fcf-d143-4fe8-a2ff-6cd596bddc6d
https://support.office.microsoft.com/client/Overview-Creating-accessible-Office-files-868ECFCD-4F00-4224-B881-A65537A7C155?NS=WINWORD&Version=15&AppVer=ZWD150
https://support.office.microsoft.com/client/Overview-Creating-accessible-Office-files-868ECFCD-4F00-4224-B881-A65537A7C155?NS=WINWORD&Version=15&AppVer=ZWD150
https://support.office.microsoft.com/client/Overview-Creating-accessible-Office-files-868ECFCD-4F00-4224-B881-A65537A7C155?NS=WINWORD&Version=15&AppVer=ZWD150
https://support.office.microsoft.com/client/Overview-Creating-accessible-Office-files-868ECFCD-4F00-4224-B881-A65537A7C155?NS=WINWORD&Version=15&AppVer=ZWD150
https://support.office.microsoft.com/client/Overview-Creating-accessible-Office-files-868ECFCD-4F00-4224-B881-A65537A7C155?NS=WINWORD&Version=15&AppVer=ZWD150
https://support.office.microsoft.com/client/Create-accessible-Word-documents-4fbb34d6-264f-4315-98d1-e431019e6137
https://support.office.microsoft.com/client/Create-accessible-Word-documents-4fbb34d6-264f-4315-98d1-e431019e6137
https://support.office.microsoft.com/client/Create-accessible-Word-documents-4fbb34d6-264f-4315-98d1-e431019e6137
https://support.office.microsoft.com/client/Create-accessible-Word-documents-4fbb34d6-264f-4315-98d1-e431019e6137
https://support.office.microsoft.com/client/Make-your-Word-documents-accessible-D9BF3683-87AC-47EA-B91A-78DCACB3C66D?NS=WINWORD&Version=15&AppVer=ZWD150
https://support.office.microsoft.com/client/Make-your-Word-documents-accessible-D9BF3683-87AC-47EA-B91A-78DCACB3C66D?NS=WINWORD&Version=15&AppVer=ZWD150
https://support.office.microsoft.com/client/Make-your-Word-documents-accessible-D9BF3683-87AC-47EA-B91A-78DCACB3C66D?NS=WINWORD&Version=15&AppVer=ZWD150
https://support.office.microsoft.com/client/Make-your-Word-documents-accessible-D9BF3683-87AC-47EA-B91A-78DCACB3C66D?NS=WINWORD&Version=15&AppVer=ZWD150
https://support.office.microsoft.com/client/Make-your-Word-documents-accessible-D9BF3683-87AC-47EA-B91A-78DCACB3C66D?NS=WINWORD&Version=15&AppVer=ZWD150
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Resource Link Description 
Accessibility Checker 
 

https://support.office.microsoft.com/clien
t/Accessibility-Checker-a16f6de0-2f39-

4a2b-8bd8-5ad801426c7f  

A tool used to check Office files for 
accessibility.  A great way to review 

existing documents.   

Rules for Accessibility Checker 
 

https://support.office.microsoft.com/clien
t/Accessibility-Checker-Rules-651e08f2-

0fc3-4e10-aaca-
74b4a67101c1#bkmk_checkerrules  

One section of the Microsoft Office 
online resource that explains how 

the accessibility checker works and 
rules it follows.  

Create Accessible PDF files 

 
https://support.office.microsoft.com/clien

t/Create-accessible-PDFs-064625e0-
56ea-4e16-ad71-3aa33bb4b7ed  

PDF file format are widely used on 

the Internet and websites.   

Make your PowerPoint presentations 
accessible 

 
https://support.office.microsoft.com/clien

t/Office-Accessibility-Center-ecab0fcf-

d143-4fe8-a2ff-6cd596bddc6d  
 

Best practices for making 
PowerPoint presentations accessible 

 

  

https://support.office.microsoft.com/client/Accessibility-Checker-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f
https://support.office.microsoft.com/client/Accessibility-Checker-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f
https://support.office.microsoft.com/client/Accessibility-Checker-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f
https://support.office.microsoft.com/client/Accessibility-Checker-Rules-651e08f2-0fc3-4e10-aaca-74b4a67101c1#bkmk_checkerrules
https://support.office.microsoft.com/client/Accessibility-Checker-Rules-651e08f2-0fc3-4e10-aaca-74b4a67101c1#bkmk_checkerrules
https://support.office.microsoft.com/client/Accessibility-Checker-Rules-651e08f2-0fc3-4e10-aaca-74b4a67101c1#bkmk_checkerrules
https://support.office.microsoft.com/client/Accessibility-Checker-Rules-651e08f2-0fc3-4e10-aaca-74b4a67101c1#bkmk_checkerrules
https://support.office.microsoft.com/client/Create-accessible-PDFs-064625e0-56ea-4e16-ad71-3aa33bb4b7ed
https://support.office.microsoft.com/client/Create-accessible-PDFs-064625e0-56ea-4e16-ad71-3aa33bb4b7ed
https://support.office.microsoft.com/client/Create-accessible-PDFs-064625e0-56ea-4e16-ad71-3aa33bb4b7ed
https://support.office.microsoft.com/client/Office-Accessibility-Center-ecab0fcf-d143-4fe8-a2ff-6cd596bddc6d
https://support.office.microsoft.com/client/Office-Accessibility-Center-ecab0fcf-d143-4fe8-a2ff-6cd596bddc6d
https://support.office.microsoft.com/client/Office-Accessibility-Center-ecab0fcf-d143-4fe8-a2ff-6cd596bddc6d
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Multimedia Content Accessibility 
Audio and video content will require a readable version (transcription or closed 
captioning) to make it accessible.  Past practices have been to use a third-party to 

transcribe the content in existing recordings for students who need an accommodation.  
Third-party use is expensive, inconvenient, and has a long turnaround time.  

 
The ability to create a transcript or closed captioning easily and quickly is the ultimate 

solution for audio content accessibility.  Although this version of the guidelines does not 
have a final solution for transcription/closed captioning in place, a solution is under 

review for the campus and more information will be forthcoming.  
 

In the meantime, there are several things that can be done to prepare multimedia 
content for accessibility.  If audio only, be sure the sound is clear, understandable, and 

well edited to remove extraneous content.  Likewise, video content should be 
understandable and well edited.  If content is questionable, consider recording again.  If 

possible, before recording, script out your content then follow the script as you record.  

This will allow you to publish the script and the recorded content together, thus making 
it accessible in two formats.  

 
It is recommended for individuals who create multimedia content to review the website 

https://www.w3.org/2008/06/video-notes#q1  for helpful information on accessible 
audio and video recordings.  

  

https://www.w3.org/2008/06/video-notes#q1
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Online Training Resources  

Federal Government Training on Section 508 

Understanding Section 508 is important for all faculty and staff.  The federal government 

has a site where our faculty and staff can learn about Section 508 online.  Topics 
addressed at http://traning.section508.gov  include: 

 
Designing Accessible Web Sites 

Accessible Conferences  
Buying Accessible Electronic and Information Technology products/services 

Section 508 Coordinators 
 

As a member of an educational institution, you can access some of the resources on this 

site by registering with your @Athens.edu e-mail address. 
 

 
 

Additional Online Training Resources 

Mentioned earlier in this document, Microsoft has some excellent online tutorials that 
provide guidance on creating accessible documents. 

(https://support.office.microsoft.com/client/Create-accessible-Word-documents-
4fbb34d6-264f-4315-98d1-e431019e6137).  Also, Search YouTube for “making 

documents accessible” and you will find a number of great tutorials on accessibility 
techniques.   

 

http://traning.section508.gov/
https://support.office.microsoft.com/client/Create-accessible-Word-documents-4fbb34d6-264f-4315-98d1-e431019e6137
https://support.office.microsoft.com/client/Create-accessible-Word-documents-4fbb34d6-264f-4315-98d1-e431019e6137
https://support.office.microsoft.com/client/Create-accessible-Word-documents-4fbb34d6-264f-4315-98d1-e431019e6137
https://support.office.microsoft.com/client/Create-accessible-Word-documents-4fbb34d6-264f-4315-98d1-e431019e6137
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General Procurement Practices  
The procurement process at Athens State will include the review proposed purchases for 
accessibility.  Products that will be subject to accessibility review are:   

 
Software applications  

Web-based internet and intranet information and applications 
Telecommunications products 

Video and multimedia products 
Printers/copier, kiosks, fax machines 

Desktop and portable computers  
 

Products/services will need the following information to determine accessibility 

compliance:  
 

Who will use the product/service? Campus-wide, academic labs, employee workstations, 
etc. 

Is this a new or previous purchase? 
Provide the vendor Voluntary Product Accessibility Template URL 
 

Instructional Resources 

Blackboard Learn 

The learning management system, Blackboard Learn, has incorporated in the design of 

its interface the Section 508 and WCAG 2.0, Level AA accessibility standards.  This is a 
great beginning to making course content accessible to all students.  However, a web 

site or document accessed through Blackboard but was developed outside of the 
Blackboard interface, must also follow accessibility standards.  

 

Textbooks and Academic Software Applications/Websites  

Like the general procurement practices described previous, when faculty choose a new 
textbook and accompanying software applications/guides, accessibility should be part of 

the review process.  Textbook selection, however, differs from general procurement 
issues because accessibility issues are handled differently. Textbooks are intellectual 

property and chosen based upon the subject or program requirements.  To address 
accessibility, the availability of an e-text formatted textbook is ideal because the e-text 

allows for a quicker turnaround time to provide an accommodation for a student.  Most 

large publishing companies have an online request form for e-text versions of the 
textbook and some may require confirmation of the reason for e-text access and that 

the student owns a purchased copy of the textbook.   
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If you receive an e-text of a textbook from the publisher, it may not be in the ideal 

format for your student, but can be converted to a useable format.   
 

If the same textbook and/or accompanying software application have been used for a 
long time please to review it for accessibility issues as previously suggested.  

Other products/services 

Voluntary Product Accessibility Template (VPAT) details how a company will comply with 

the federal Section 508 standards.  Do a Google search on company or product name 
followed by VPAT and you will find a description of accessibility compliance for that 

product.  While VPATs are currently used to describe Section 508 compliance, any 
accessibility standards and guidelines, such as WCAG can be applied in a similar format 

to the VPAT. 
 

 

Additional Helpful Accessibility Links  
 

https://support.office.microsoft.com/en-us/word  
 

https://section508.gov/content/quick-reference-guide#1194.24  
 

https://training.section508.gov/index.cfm 
 

http://www.adobe.com/accessibility.html 
 

https://helpx.adobe.com/acrobat/using/create-verify-pdf-

accessibility.html?trackingid=KRRSC&DTProd=Reader&DTServLvl=SignedOut#make_PD
Fs_accessible  

 
 

 

https://support.office.microsoft.com/en-us/word
https://section508.gov/content/quick-reference-guide#1194.24
https://training.section508.gov/index.cfm
http://www.adobe.com/accessibility.html
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html?trackingid=KRRSC&DTProd=Reader&DTServLvl=SignedOut#make_PDFs_accessible
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html?trackingid=KRRSC&DTProd=Reader&DTServLvl=SignedOut#make_PDFs_accessible
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html?trackingid=KRRSC&DTProd=Reader&DTServLvl=SignedOut#make_PDFs_accessible



